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SUMMARY 20 

 21 

The goal of this protocol is to determine species- and site-specific confidence score thresholds 22 

using logistic regression to improve detection precision in large acoustic datasets processed with 23 

automated acoustic recognition software.  24 

 25 

ABSTRACT 26 

 27 

Passive acoustic monitoring (PAM) has become an invaluable tool for biodiversity research, 28 

enabling the non-invasive collection of vast datasets. However, a significant challenge remains in 29 

efficiently and reliably processing this large volume of data to extract species-specific information 30 

across varying locations. This paper presents a detailed, step-by-step protocol to address this 31 

challenge using a machine learning detector module within a bioacoustics analysis software. The 32 

methodology is designed to accurately and confidently identify and validate bird vocalisations 33 

from raw acoustic recordings. 34 

 35 

Our protocol details the process from initial data collection using autonomous recording units 36 

(ARUs) to the final generation of a high-quality annotated dataset. Key steps include configuring 37 

the machine learning detector module to generate initial detections, a manual validation 38 

procedure to calculate precision tables, and a logistic regression analysis to determine a species-39 

specific and, where appropriate, a location-specific confidence score threshold. This statistically 40 

derived threshold is then used to refine the detector’s output, tested on two overlap 41 

configurations (0 s and 2 s). We show that applying the derived optimal confidence score 42 

thresholds substantially improves the machine learning-based avian sound recognition models 43 

detection precision across sites. For the three sites used to illustrate the process (Liverpool Park, 44 



   

 

Cairngorms, and Glasgow Suburban) precision increased by 26.1%, 17.7%, and 17% for an overlap 45 

of 0 s, and by 28.77%, 16.87%, and 15% for an overlap of 2 s. We suggest the resulting 46 

methodology is superior to manual counting methods in both speed and reliability. In summary, 47 

this paper provides a reproducible framework that facilitates the accessible and effective use of 48 

machine learning approaches in bioacoustics, enabling researchers to confidently leverage large 49 

acoustic datasets for ecological studies and parameter analysis. 50 

 51 

INTRODUCTION 52 

 53 

Animal vocalisations offer valuable insights into the natural world and act as powerful biological 54 

tools allowing researchers to investigate various aspects of animals lives1. The field of 55 

bioacoustics has become increasingly important in biodiversity monitoring and conservation, 56 

aiding in species identification and in assessing population trends and ecosystem health2,3,4. This 57 

field of research also contributes to our understanding of animal behaviour, for example, in 58 

communication and habitat use5,6. More recently, it has been demonstrated as a promising 59 

approach for assessing animal welfare7,8. 60 

One of the key advantages of using acoustic analysis as a research tool is the recent technological 61 

advances in autonomous recording units (ARUs), which enable researchers to non-invasively and 62 

remotely monitor animal vocalisations for extended periods of time, a technique known as 63 

passive acoustic monitoring (PAM)9. This has allowed for the collection of data from cryptic 64 

species without human intervention10,11. Additionally, ARUs are cost-effective and minimise the 65 

need for trained researchers to be in the field9. A study on the cryptic European nightjar 66 

(Caprimulgus europaeus) demonstrated these advantages, finding that the use of ARUs was 67 

significantly more effective than human observers in detecting the species12. Large-scale 68 

bioacoustics studies are increasingly becoming more popular because they can provide insights 69 

into a range of ecological and behavioural aspects, they are also highly applicable and well-suited 70 

for field studies. Yet ARUs running for long periods mean researchers are inevitably faced with 71 

the challenge of efficiently and reliably processing vast amounts of acoustic data13.  72 

More recently, researchers have begun combining PAM with the use of automatic recognition 73 

tools to detect species within large datasets, enhancing and speeding up the overall processing 74 

of data. These techniques automatically recognise and classify species based on vocalisation 75 

type13, often using machine learning and deep learning models such as artificial neural networks, 76 

which have gained traction in recent years14. The reliability of automatic recognition software is 77 

often superior to manual methods of species detection, as demonstrated in studies on Giant 78 

Panda (Ailuropoda melanoleuca) vocalisations15 and Malaysian frog species16. Importantly, one 79 

of the primary drivers behind adoption of these approaches is processing speed, particularly as 80 

the volume of acoustic data generated through PAM continues to grow13. Manual analysis of 81 

large acoustic datasets is inefficient and impractical at scale, yet automated recognition tools can 82 

process recordings in a fraction of the time required by a human observer. For example, one 83 

study reported that 257 h of manual visual scanning was equivalent to 1 h of processing time 84 

using BirdNET (machine learning–based avian sound recognition model)17. 85 

 86 



   

 

This machine learning–based avian sound recognition model is one such tool that has recently 87 

gained traction for its use in ornithology and other acoustics studies, it is an accessible automated 88 

software for bird species identification that relies on a deep learning model18,19. Most studies to 89 

date have used the machine learning–based avian sound recognition model to generate species 90 

lists for a given area, and with human validation it has been shown to detect 89% of species in a 91 

community, while requiring less than a quarter of the time used by visual scanning alone17. This 92 

machine learning–based avian sound recognition model has also been shown to effectively 93 

identify the presence of a specific target species in an area, such as the Eurasian Bittern (Botaurus 94 

stellaris), with a 93.7% success rate20. However, this model often has a higher success rate when 95 

combined with manual validation and isn’t yet reliable as a fully automatic detection tool21. There 96 

are also other challenges to consider according to Wood and Kahl21 regarding its production of 97 

unitless predictions. 98 

 99 

The machine learning detector module assigns each detected bird vocalisation a quantitative 100 

confidence score between 0 and 1, which indicates how certain the software is that the detected 101 

sound has been correctly identified as a particular species18,19,21. Precision, defined as the 102 

proportion of detections that are true positives (i.e. correct identifications), is a key metric 103 

influenced by this score22. Consequently, a higher confidence score may produce less detections, 104 

but with higher precision, yet miss detections especially in noisy environments, and a lower score 105 

may produce more detections with less certain precision22,23. The relationship between the 106 

confidence scores and precision is complex, it is often found that some high confidence scores 107 

can be false positives, for example in locations with high levels of background noise, or with 108 

species that are likely to mimic other species vocalisations23,24. Due to the variability in precision 109 

among species and location, it is possible during the configuration process to assign individual 110 

confidence score thresholds to each bird species, whereby only detections with scores above that 111 

threshold will be labelled. A high universal confidence score threshold could be applied across all 112 

species and locations, however, doing so often increases the number of false negatives (missed 113 

identifications)22,25,26, while the number of false positives vary between species and with 114 

environmental differences between recordings. 115 

 116 

Several studies and best-practice guidelines outline various methods for determining an optimal 117 

confidence score threshold at which to run the machine learning detector module for specific 118 

species and study locations, enabling detections to be accepted with greater confidence as true 119 

positives21,24,26–28. One approach involves calculating F-scores across a range of confidence 120 

thresholds and selecting the threshold that maximises the F-score, balancing both precision and 121 

recall29,30. An alternative approach, which allows for probability calibration, involves manually 122 

validating a random subset of predictions and fitting a logistic regression to establish a 123 

relationship between the binary validation outcome (true/false detection) and the associated 124 

confidence score21. This method can then be used to determine context-specific thresholds, 125 

which may be adjusted across species and environmental conditions (e.g., varying background 126 

noise)19. Such methods have been applied in passive acoustic monitoring studies on Yucatán 127 

black howler monkeys (Alouatta pigra), gray wolves (Canis lupus) and coyotes (C. latrans)27,28.  128 

 129 



   

 

The aim of this methods paper is to demonstrate and validate a scalable methodology for 130 

accurately and reliably extracting species-specific vocal data from large acoustic datasets using 131 

the machine learning–based avian sound recognition model within Raven Pro-bioacoustics 132 

analysis software (ver 1.6)19,31. This approach incorporates the calculation of appropriate 133 

confidence score thresholds following Wood and Kahl’s21 best-practice guidelines. While these 134 

guidelines21 provide a comprehensive framework for applying confidence scores within the 135 

machine learning–based avian sound recognition model19, they are primarily presented as best-136 

practice recommendations. Few studies have operationalised these procedures across 137 

distributed ARU study systems under realistic monitoring constraints, where acoustic conditions 138 

and background noise vary spatially22. This protocol is particularly suitable for large-scale passive 139 

acoustic monitoring studies involving multiple sites, variable acoustic environments, or target 140 

species with high misclassification rates. Furthermore, the implementation of these guidelines 141 

within the bioacoustics analysis software (ver 1.6)19,31, a more accessible and user-friendly 142 

platform compared to coding-based environments32,33 has not been previously demonstrated.  143 

 144 

To address this gap, we apply and validate the protocol using large-scale datasets recorded with 145 

AudioMoths - ARUs (ver 1.2.0)34,35, across a diverse range of habitats. Our focal species the 146 

European Robin (Erithacus rubecula), exhibits high song variability and structural complexity36,37, 147 

and demonstrated a susceptibility to misidentification in initial pilot analyses. By applying 148 

species- and site-specific confidence score thresholds to the machine learning–based avian sound 149 

recognition model configuration within the bioacoustics analysis software19,31, we evaluate the 150 

protocol under varying acoustic conditions, incorporating differing background noise levels and 151 

species assemblages, and demonstrate that tailoring threshold optimisation can substantially 152 

improve detection precision in comparison to default settings. This approach is designed to 153 

ultimately facilitate accessible, streamlined, and efficient application of the machine learning–154 

based avian sound recognition model19 for in large scale PAM studies, with minimal coding.  155 

 156 

PROTOCOL 157 

 158 

Ethics statement 159 

 160 

This protocol follows the ethical guidelines of Liverpool John Moores University. No animals were 161 

handled, disturbed, or experimentally interfered with during data collection. The study involved 162 

passive acoustic monitoring only and did not include the handling, disturbance, or experimental 163 

manipulation of animals. No hazardous procedures were required to deploy the ARU units. 164 

Autonomous recording units were deployed in accordance with institutional research and 165 

fieldwork guidelines, and appropriate signage was installed at recording sites to inform the public 166 

of acoustic monitoring. However, check weather forecasts before conducting field activity and to 167 

conduct a risk assessment for each site 168 

 169 

Software, licensing and usage  170 

 171 

NOTE: Process ARU units data using the machine learning–based avian sound recognition model 172 

within the bioacoustics analysis software (v1.6)19,31 and same software (v1.6)31 for detector 173 



   

 

output processing. This is a licensed software and is not freely available, use of the workflow 174 

described here therefore requires access via an institutional or individual license. In addition, the 175 

machine learning–based avian sound recognition model within the software (v1.6)19,31, does not 176 

currently run on Apple devices with ARM-based processor architecture (M1 or M2 chips), 177 

however this protocol is compatible with macOS-based computers with Intel CPUs and Windows 178 

operating systems.  179 

 180 

1. Collecting audio data 181 

 182 

1.1.  Prepare ARUs for deployment. 183 

 184 

1.1.1. Insert batteries into the ARUs (rechargeable alkaline batteries were used during 185 

this experiment).  186 

 187 

1.1.2. Insert appropriately sized removable memory cards relative to the amount of data 188 

to be collected (2 GB removable memory cards were used during this experiment). 189 

 190 

Note: For recording schedules producing 108, 1 min files per day over a 30 day period (see step 191 

1.2.5.2), each file was approximately 5760 kB, resulting in a total data volume of 622 MB. With 192 

an estimated daily energy consumption of 26 mAh. Therefore, removable memory cards with a 193 

capacity of 2 GB were used for the representative results to provide sufficient storage. 194 

Additionally, rechargeable alkaline batteries retained usable power for the longest period, as 195 

opposed to lithium AA batteries and rechargeable NiMH, under the test conditions.  196 

 197 

1.2. Configure each ARU for deployment 198 

 199 

1.2.1. Download the ‘ARU device firmware update application’39 and the ‘ARU device 200 

configuration application’40 from the ‘App Download Page’ on the ARU website41. 201 

 202 

1.2.2. Connect the ARUs individually to a computer using a data transfer cable. 203 

 204 

1.2.3. Ensure the device is switched to the USB/Off mode.  205 

 206 

1.2.4. Use the ARU device firmware update application’39 to update the devices to the 207 

latest firmware. 208 

 209 

1.2.5. Use the ‘ARU device configuration application’40 to set the ARUs to record at a 210 

target time of day for a selected number of days. Determine active recording periods 211 

and sleep intervals.  212 

 213 

1.2.5.1. Identify the time windows when target species are most active (e.g., dawn 214 

chorus for diurnal birds), and schedule recording periods accordingly.  215 

 216 



   

 

1.2.5.2. Set an appropriate duty cycle, specifying how long the ARUs are actively 217 

recording versus in sleep mode.  218 

 219 

Example: For these representative results, ARUs were programmed to record daily 220 

between 4:00–9:00 AM and 5:00–9:00 PM from 1st June-30th June 2023. These time 221 

windows were selected to capture both the dawn and dusk choruses. During active 222 

periods, devices recorded 1 min WAV files followed by a 4 min sleep interval, resulting 223 

in a total of 108 1 min recordings per day.  224 

 225 

Note: ARUs can record continually, but this rapidly increases battery consumption and 226 

removable memory card usage.  227 

 228 

1.2.5.3. Use the ‘ARU device configuration application’42 to set the devices to 229 

record at a sampling rate of 48 kHz as recommended for capturing a full range 230 

of bird vocalisations34,35 and with medium gain (typically left at default unless 231 

recording in noisy environments34,35). Other sampling rates can be used 232 

depending on the frequency of target species vocalisations, for example for 233 

ultrasonic wildlife, such as bats or amphibians, use a sampling rate of 384 kHz35.  234 

 235 

1.2.6. After configuring all ARUs, switch each device to the CUSTOM mode.  236 

 237 

1.3. Device protection and labelling 238 

 239 

1.3.1. Insert each ARU device into an Antistatic Ziplock bag. Use additional waterproof 240 

tape as needed to prevent water damage. Place Silica Gel packets inside the bags to 241 

absorb moisture.  242 

 243 

1.3.2. Label each ARU by number and its location.  244 

 245 

1.4. ARU deployment  246 

 247 

1.4.1. Determine locations for ARUs recorders to be deployed within the target species 248 

habitat.  249 

 250 

1.4.2. Deploy ARUs at spacing distances appropriate to the study requirements and 251 

target species.  252 

 253 

Note: Detection distance depends on habitat, background noise, and species’ call volume. 254 

While loud species (e.g., Eurasian bittern) can be detected by ARUs up to 800 m, 255 

recordings degrade at longer ranges, limiting fine scale measurements20. Here, one ARU 256 

per site was analysed, with units about 100 m apart to ensure good spatial coverage and 257 

clear vocalisations. Adjust spacing according to species, habitat, and project goals. 258 

 259 



   

 

2. Using the machine learning detector module in the bioacoustics analysis software19,31 for 260 

automatic species detection 261 

 262 

2.1. Transfer audio data  263 

 264 

2.1.1. After the deployment period has ended, remove removable memory cards from 265 

the ARUs, keeping note of which removable memory cards correspond to each 266 

numbered ARU.  267 

 268 

2.1.2. Transfer all WAV files from each removable memory cards onto a computer using 269 

a card reader.  270 

 271 

2.1.3. Organise all WAV files generated from each ARU into folders labelled with the 272 

corresponding ARU number and location. 273 

 274 

2.1.4. Save back up versions of all data onto additional devices. Pause point: Protocol 275 

can be paused here. 276 

 277 

2.1.5. Restrict access to this data to authorised project researchers and ensure data is 278 

password protected to maintain confidentiality, particularly where human activity 279 

may have been inadvertently recorded. 280 

 281 

2.2. Configure the machine learning detector module. 282 

 283 

2.2.1. Open the bioacoustics analysis software31 and under the drop-down menu select 284 

Tools > Detector > Learning Detector. 285 

 286 

2.2.2. In the Choose Detector Inputs window, select Browse. In the subsequent Open 287 

Sound Files window, select all the WAV files within the relevant ARU folder and click 288 

Open (Supplementary Files S1 and S2). 289 

 290 

2.2.3. In the Configure New Sound Window that opens, under Paging > Page Sound, 291 

enter the appropriate Page Size for the length of each recording (e.g., 60 s for 1 min 292 

WAV files) (Supplementary File S3).  293 

 294 

2.2.4. In the same Configure New Sound Window, under Multiple Files select Open as 295 

file sequence in one window, then click OK (Supplementary File S3).  296 

 297 

2.2.5. In the returning Choose Detector Inputs window, select Waveform under 298 

Available Signals and Views on the right and click the << arrows button to move it 299 

over to Required Inputs. Confirm that the status under the Required Inputs box 300 

reads Ready!, and click OK (Supplementary File S4). 301 

 302 



   

 

2.2.6. In the Configure Machine Learning Detector window that appears, under the 303 

Inputs tab, select the desired model from Select Model. When analysing bird species 304 

use the global avian classification model, which among various updates include over 305 

3000–6000 bird species19 (Supplementary File S5). 306 

 307 

2.2.7. Under the Inputs tab, leave the Overlap at the default of 0 s to prevent any 308 

interference with the subsequent confidence score threshold analysis 309 

(Supplementary File S5). 310 

 311 

2.2.8. Under the Outputs tab, select the drop-down menu Output Class File and select 312 

the output list that relates to the geographical location of the study (Supplementary 313 

File S6). 314 

 315 

2.2.9. Under the Outputs tab there will be a list of bird species relevant to the chosen 316 

Output Class File. Lower the Threshold to 0.1 and select Apply All, make sure that 317 

all values under Threshold are now at 0.1 in the list (Supplementary File S6). 318 

 319 

2.2.10. Select the Suppress All Species option and ticks will appear in all boxes in the 320 

species list. Then locate the target species and un-tick it in the Suppress column 321 

(Supplementary File S6). 322 

 323 

2.2.11.  Select OK to begin the Learning Detector, this will process the files and create 324 

selections where it has detected the target species vocalisations.  325 

 326 

2.2.12. Monitor the Progress Manager to track Percentage Completed and Time 327 

Remaining (Supplementary File S7).  328 

 329 

2.3. Save the Learning Detector output  330 

 331 

Note: A Learning Detector table will be generated during processing and displayed 332 

beneath the spectrogram view. The numbered selections in this table correspond to the 333 

detector’s identified selections on the spectrogram view. Each selection is fixed at 3 s in 334 

length and may not always be repeated over the entire vocalisation being detected. Each 335 

selection is assigned an identification Label and Score in the selection table 336 

(Supplementary File S8). These scores are a unitless prediction and will be used in the 337 

logistic regression analysis in subsequent stages.  338 

 339 

2.3.1. Select File > Save Selection Table “Learning Detector” As and save the file using 340 

the ARU name and an identifier such as: AM1_LearningDetectorTable_Original.txt. 341 

 342 

3. Create precision tables for target species at a representative ARU from each study location 343 

 344 

3.1. Prepare the validation dataset 345 

 346 



   

 

3.1.1. Open the Learning Detector selection table that was saved in step 2.3.1 and 347 

transfer to a spreadsheet software. 348 

 349 

3.1.2. Confirm that only the target species appears under the Label column.  350 

 351 

3.1.3. Delete all columns apart from the Selection and Score column.  352 

 353 

3.1.4. Randomise the rows using the spreadsheet’s randomisation function (e.g., add a 354 

column using =RAND(), sort this column, then delete the randomisation column).  355 

 356 

3.1.5. Retain the first 300 randomised detections, if fewer than 300 exist, retain all 357 

detections. 358 

 359 

Note: Selecting 300 detections for validation is standard in similar studies using 1 month 360 

of acoustic data24. This sample size estimates precision and mislabelling rates reliably, 361 

captures a range of detection scores, and keeps workload manageable. More selections 362 

may be needed for longer datasets. 363 

 364 

3.1.6. Save the validation dataset using the ARU name being analysed and an identifier 365 

such as: AM1_ValidationDataset.xlsx.  366 

 367 

3.2. Prepare bioacoustics analysis software for manual validation 368 

 369 

3.2.1. Open the software31, select File > Open Sound Files… and in the Open Sound Files 370 

window select all the corresponding WAV files for the ARU being analysed, and click 371 

Open.  372 

 373 

3.2.2. In the Configure New Sound Window which opens, under Paging, select Page 374 

Sound and enter the Page size used in step 2.2.3. Under Multiple Files select Open 375 

as file sequence in one window and select OK.  376 

 377 

3.2.3. Navigate to File > Open Selection Table… and open the Learning Detection Table 378 

for the ARU being analysed saved in step 2.3.1. 379 

 380 

3.2.4. In the Panel on the left of the Sound view, under the Layouts tab, in Views:, 381 

unselect the Waveform view so all files are displayed in Spectrogram view to enable 382 

visual confirmation of vocalisation structure.  383 

 384 

3.3. Validate randomised selections 385 

 386 

3.3.1. Alongside the bioacoustics analysis software31 with the prepared data ready for 387 

manual validation, open the validation spreadsheet saved in step 3.1.6. 388 

 389 

3.3.2. Create a new column in the spreadsheet labelled Correctly Detected.  390 



   

 

 391 

3.3.3. Locate each selection number from the randomised list within the spectrogram 392 

view and input whether it has been correctly detected (1) or incorrectly detected (0) 393 

into the Correctly Detected column. 394 

 395 

3.4. Calculate detector precision 396 

 397 

3.4.1. Calculate precision of the detector (prior to the logistic regression) for the ARU 398 

and target species using the formula: 399 

 400 

3.4.2. Precision (%) = (Number of correct detections/Total validated detections) x 100 401 

 402 

3.4.3. For datasets with precision of 90% or greater, retain current detector settings. 403 

 404 

3.4.4. For datasets with precision lower than 90%, carry onto section 4 to fit a logistic 405 

regression analysis to determine the optimal threshold to set the detector to run at.  406 

 407 

Note: When precision falls below 90%, high mislabelling rates make reliable extraction of 408 

vocalisations difficult without threshold adjustment. A 90% cut-off balances detection 409 

reliability with adequate sample size. Previous machine learning–based avian sound 410 

recognition model calibration studies also regard precision rates of 90% and above as 411 

being sufficiently reliable42.  412 

 413 

4. Perform a logistic regression analysis on the validation tables to generate an optimal 414 

confidence score threshold 415 

 416 

4.1. Generate confidence score thresholds, utilising Wood & Kahl’s21 guidelines 417 

 418 

4.1.1. Use the software R32 to import the validation dataset created in section 3. 419 

 420 

4.1.2. Run a logistic regression using the generalized linear modelling function with the 421 

family as binomial on the dataset. 422 

 423 

4.1.3. Set the desired probability of precision as 0.9, this means that the probability that 424 

a detection is a true positive will be 90% or above. 425 

 426 

Note: Setting the desired probability of precision to 0.9 ensures that most detections are 427 

true positives, however, even at this level false positives can occur in large acoustic 428 

datasets and users should be aware of this limitation. A 90% precision threshold allows 429 

users to maintain high numbers of correct detections, while retaining enough data for a 430 

robust analysis, aiming for 100% would limit usable data.  431 

 432 



   

 

4.1.4. Calculate the optimal threshold by solving the fitted logistic regression equation 433 

for the predictor value (confidence score) that yields a predicted probability of 0.9 434 

using the Logistic Regression Analysis Script below: 435 

 436 

Threshold =
log (

𝑝
1 − 𝑝) − β0

β1
 437 

 438 

 439 

 440 

p = 0.9, and β0 and β1 are the intercept and slope from the fitted model 441 

 442 

Logistic Regression Analysis Script for statistical computing software 443 

# Load validation table 444 

ThresholdRobin <-read.csv('ValidationTableRobin.csv') 445 

# Run Logistic Regression 446 

Model1<-glm(Correctly.Detected~Score, data=ThresholdRobin, family='binomial') 447 

Model1 448 

# Desired probability above 90% precision 449 

p <- 0.9 # the desired p (probability of true positive) 450 

threshold <- (log(p/(1-p))- Model1$coefficients[1]) / Model1$coefficients [2] 451 

 452 

Note: Instead of using the Logit Score as in previous studies24,27 as the independent 453 

variable, use the raw confidence scores as the independent variable. In Wood and Kahl’s21 454 

guidelines it is mentioned that either the raw confidence scores or back-transformed 455 

versions can be used. 456 

 457 

4.2. Apply the optimal confidence score 458 

 459 

4.2.1. Open the bioacoustics analysis software31. 460 

 461 

4.2.2. Re-run the Learning Detector on the ARU being investigated using the steps in 462 

section 2. However, this time in the configuration process, the Threshold for the 463 

target species being detected must be changed to the threshold determined in 464 

section 4.1 of the protocol. 465 

 466 

4.2.3. (Optional) Increase Overlap to 2 s to increase detection resolution.   467 

 468 

Note: The Overlap value determines how much adjacent detected segments overlap. At 469 

0 s vocalisations on segment borders might be missed (false negatives). Increasing overlap 470 

improves detection resolution and predictive power but slows analysis19,29. Here, for the 471 

logistic regression, a default overlap of 0 s was used. With the representative results and 472 

confidence score thresholds calculated in the logistic regression analysis, an overlap of 473 

both 0 and 2 s is tested. 474 



   

 

 475 

4.2.4. A new list of detections will be created that now should be more accurate, with 476 

less false positives (see Results). 477 

 478 

4.2.5. Save the new Learning Detector output with the list of detections that were 479 

generated using the derived confidence score threshold by selecting File > Save 480 

Selection Table “Learning Detector” As and save the file using the ARU name and 481 

an identifier such as: AM1_LearningDetectorTable_OptimisedThreshold.txt. 482 

 483 

4.2.6. This file represents the final validated dataset generated by the protocol. Use the 484 

saved optimised learning detector selection table as the final output of this protocol. 485 

Please note that subsequent analyses, such as annotation of vocalisations and 486 

acoustic parameter extraction, fall outside the scope of this method. 487 

 488 

RESULTS 489 

 490 

To illustrate the effectiveness of the described protocol, we present representative results from 491 

the analysis of acoustic data for the European Robin (Erithacus rubecula) collected at three sites 492 

of varying environments and avian species assemblages, including a park in Liverpool (ARU 1), a 493 

naturally regenerating woodland site within The Cairngorms National Park (ARU 2), and a 494 

suburban site in Glasgow (ARU 3). These examples demonstrate how applying statistically derived 495 

confidence score thresholds can improve detection precision across varying acoustic 496 

environments. In this study, a successful outcome was defined as a detection precision ≥ 90% 497 

following threshold optimisation, values below this threshold were considered suboptimal and 498 

indicative of continued misidentification of species.  499 

 500 

Liverpool park - ARU 1 501 

 502 

The machine learning detector module19 was initially run on the full 1-month dataset recorded 503 

at the Liverpool Park site, with a default confidence score threshold of 0.1 and an overlap of 0 s, 504 

which resulted in 299 detections. All of these were manually validated as per section 3 of the 505 

protocol, yielding an initial detection precision of 66.56%, below the desired 90% benchmark, 506 

indicating the need for a logistic regression analysis to determine a more accurate threshold. 507 

 508 

Using the statistical computing software script provided in the protocol (step 4.1.4), a logistic 509 

regression model was fitted to the validation data to determine the relationship between the 510 

detector's confidence score and the probability of a correct detection. The model's coefficients 511 

were used to calculate a new, optimal confidence score threshold of 0.54 to achieve a precision 512 

rate of 90% or higher (Figure 1). Logistic regression analysis indicated that the machine learning 513 

detector modules optimised confidence scores significantly predicted correct classification at the 514 

Liverpool Park site (β = 5.73, SE = 1.04, z = 5.53, p < 0.001). The model showed improved fit 515 

relative to the null model (residual deviance = 329.42 vs. null deviance = 381.10; AIC = 333.42; n 516 

= 299). 517 

 518 



   

 

[Place Figure 1 here]. 519 

 520 

The machine learning detector module19 was re-run with this new threshold of 0.54 on the same 521 

full 1-month dataset recorded at the Liverpool Park site, following step 4.2 of the protocol, with 522 

and without an additional increase in overlap (0 s and 2 s). A new decreased set of 109 detections 523 

was generated for the default overlap of 0 s, whereas 354 detections were generated with the 524 

increased overlap of 2 s. A subsequent validation of these refined datasets confirmed a 525 

substantial improvement in precision. The post-regression precision with the default overlap of 526 

0 s increased to 92.66% and with the increased overlap of 2 s the precision increased to 95.33%, 527 

both above the desired 90% threshold. 528 

 529 

Cairngorms naturally regenerating woodland - ARU 2 530 

 531 

The machine learning detector module19 was initially run on the full 1-month dataset recorded 532 

at the Cairngorms Naturally Regenerating Woodland site, with a default confidence score 533 

threshold of 0.1 and overlap of 0 s, which resulted in 113 detections. All of these were manually 534 

validated as per section 3 of the protocol, yielding an initial detection precision of 82.3%, below 535 

the desired 90% benchmark, indicating the need for a logistic regression analysis to determine a 536 

more accurate threshold. 537 

 538 

Using the statistical computing software script provided in the protocol (step 4.1.4), a logistic 539 

regression model was fitted to the validation data to determine the relationship between the 540 

detector's confidence score and the probability of a correct detection. The model's coefficients 541 

were used to calculate a new, optimal confidence score threshold of 0.23 to achieve a precision 542 

rate of 90% or higher (Figure 2). Logistic regression analysis indicated that the machine learning 543 

detector modules optimised confidence score significantly predicted correct detection at the 544 

Cairngorms Naturally Regenerating Woodland site (β = 14.02, SE = 5.78, z = 2.43, p = 0.015). The 545 

model showed improved fit relative to the null model (residual deviance = 88.04 vs. null deviance 546 

= 105.50; AIC = 92.04; n = 114). 547 

 548 

[Place Figure 2 here]. 549 

 550 

The machine learning detector module19 was re-run on the full 1-month dataset recorded at the 551 

Cairngorms Naturally Regenerating Woodland site, with the new threshold of 0.23, following step 552 

4.2 of the protocol, with and without an additional increase in overlap (0 s and 2 s). A new 553 

decreased set of 34 detections was generated for the default overlap of 0 s, whereas 121 554 

detections were generated with the increased overlap of 2 s. A subsequent validation of these 555 

refined datasets confirmed a substantial improvement in precision. The post-regression precision 556 

with the default overlap of 0 s increased to 100% and with the increased overlap of 2 s the 557 

precision increased to 99.17%, both well above the desired 90% threshold. 558 

 559 

Glasgow suburban - ARU 3 560 

 561 



   

 

The machine learning detector module19 was initially run on the full 1-month dataset recorded 562 

at the Glasgow Suburban site, with a default confidence score threshold of 0.1 and overlap of 0 563 

s, which resulted in 1240 detections. A randomised sample of 300 of these detections was 564 

manually validated as per section 3 of the protocol, yielding an initial detection precision of 565 

72.33%. This precision value, falling below the desired 90% benchmark, indicated the need for a 566 

logistic regression analysis to determine a more accurate threshold. 567 

 568 

Using the statistical computing software script provided in the protocol (step 4.1.4), a logistic 569 

regression model was fitted to the validation data to determine the relationship between the 570 

detector's confidence score and the probability of a correct detection. The model's coefficients 571 

were used to calculate a new, optimal confidence score threshold of 0.36 to achieve a precision 572 

of 90% or higher (Figure 3). Logistic regression analysis showed that the machine learning 573 

detector modules optimised confidence score was a significant predictor of correct classification 574 

(β = 9.71 ± 1.79 SE, z = 5.42, p < 0.001). The model showed improved fit relative to the null model 575 

(residual deviance = 268.88 vs. null deviance = 353.87; AIC = 272.88; n = 300). 576 

 577 

[Place Figure 3 here]. 578 

 579 

The machine learning detector module19 was re-run on the full 1-month dataset recorded at the 580 

Glasgow Suburban site, with this new threshold of 0.36, following step 4.2 of the protocol, with 581 

and without an additional increase in overlap (0 and 2 s). A new decreased set of 346 detections 582 

was generated for the default overlap of 0 s, whereas 1003 detections were generated with the 583 

increased overlap of 2 s. A subsequent validation of these refined datasets confirmed a 584 

substantial improvement in precision. The post-regression precision with the default overlap of 585 

0 s increased to 89.33%, and with the increased overlap of 2 s the precision increased to 87.33%. 586 

This outcome demonstrates that threshold optimisation improves precision but may not always 587 

achieve predefined targets in acoustically complex environments. 588 

 589 

These representative results demonstrate that while a default threshold may provide a 590 

reasonable starting point, the protocol's use of a species and location-specific logistic regression 591 

analysis is crucial for generating a highly accurate and reliable dataset for further ecological 592 

analysis. For the three sites used to illustrate the process (Liverpool Park, Cairngorms, and 593 

Glasgow Suburban), precision increased by 26.1%, 17.7%, and 17% for an overlap of 0 s, and by 594 

28.77%, 16.87%, and 15% for an overlap of 2 s. Overall precision improved by 15–28.77% across 595 

sites following the optimisation of confidence scores, and final precision ranged from 87.33–596 

100%, demonstrating that protocol performance varies depending on acoustic environment and 597 

species assemblages.  598 

 599 

FIGURE AND TABLE LEGENDS 600 

 601 

Figure 1: Logistic regression showing the probability of correct detection as a function of the 602 

machine learning–based avian sound recognition model confidence scores for Robin detections 603 

at ARU 1 at the Liverpool Park site. Points represent manually validated detections (0 = false 604 

positive, 1 = true positive). The solid blue line represents the fitted logistic regression model, and 605 



   

 

the shaded region represents the 95% confidence interval. The vertical green dashed line marks 606 

the derived confidence score threshold corresponding to 90% predicted precision. 607 

 608 

Figure 2: Logistic regression showing the probability of correct detection as a function of the 609 

machine learning–based avian sound recognition model confidence scores for Robin detections 610 

at ARU 2 at the Cairngorms site. Points represent manually validated detections (0 = false 611 

positive, 1 = true positive). The solid blue line represents the fitted logistic regression model, and 612 

the shaded region represents the 95% confidence interval. The vertical green dashed line marks 613 

the derived confidence score threshold corresponding to 90% predicted precision. 614 

 615 

Figure 3: Logistic regression showing the probability of correct detection as a function of the 616 

machine learning–based avian sound recognition model confidence scores for Robin detections 617 

at ARU 3 at the Glasgow site. Points represent manually validated detections (0 = false positive, 618 

1 = true positive). The solid blue line represents the fitted logistic regression model, and the 619 

shaded region represents the 95% confidence interval. The vertical green dashed line marks the 620 

derived confidence score threshold corresponding to 90% predicted precision. 621 

 622 

Table 1: Comparison of Robin detection metrics before and after applying the calculated 623 

confidence score threshold. Precision (%) was calculated as the proportion of manually validated 624 

true positives relative to the total validation detection count. Precision (%) was tested at both a 625 

0 s overlap (ol 0) and 2 s overlap (ol 2), which were applied during detector configuration.  626 

 627 

DISCUSSION 628 

 629 

The use of the protocol set out in this paper provides a reliable, streamlined method for 630 

generating species-specific and accurately classified datasets of bird vocalisations, which has 631 

proven useful when handling large audio datasets. We chose to test the protocol on the European 632 

Robin due to its well-known structural and frequency variability within its song repertoires43. 633 

Meaning initially, detections were found to have high mislabelling (false positive) rates (Table 1). 634 

We also validated the use of these methods with post-protocol testing to calculate increases in 635 

precision rates using the newly derived confidence score thresholds. The representative results 636 

use manual validation of Robin vocalisations and subsequent logistic regression analysis to obtain 637 

confidence score thresholds to increase detection precision when using the machine learning 638 

detector module19. The aim was to increase precision to at least 90%, which was achieved for 639 

two of the three location-based datasets. Precision for ARU 2 in the Cairngorms increased to 640 

100% (overlap 0) and 99.17% (overlap 2). Precision for ARU 1 in Liverpool Park increased to 641 

92.66% (overlap 0) and 95.33% (overlap 2). Critical steps in this protocol that strongly influenced 642 

detection precision, include randomisation and correct manual validation of detections, accurate 643 

fitting of the logistic regression model to the validation datasets, and application of the newly 644 

derived confidence score threshold during reconfiguration of the detector. 645 

 646 

Precision did increase for ARU 3 at the Glasgow Suburban site, to 89.33% (overlap 0) and 87.33% 647 

(overlap 2), when using the confidence score thresholds derived from the protocol, representing 648 

increases of 17% and 15% in precision. However, these values failed to reach the statistically 649 



   

 

determined 90% precision rate. The false positives observed here were primarily associated with 650 

mislabelling of acoustically similar species and noise as Robin vocalisations. Song Thrush (Turdus 651 

philomelos) song and the introductory phrases of Blue Tit songs (Cyanistes caeruleus) were often 652 

mislabelled as Robin vocalisations, and non-biological sounds such as rustling and rain were 653 

mislabelled as Robin ‘tic’ alarm calls. In some instances, these false positives were given higher 654 

confidence scores than some true positives. Further increase of the confidence score may 655 

improve precision slightly, however this would result in a reduction in recall. The persistence of 656 

false positives due to acoustically similar species and noise are the limitations of the model under 657 

specific environmental conditions. In practice, if precision remains below the desired threshold, 658 

users may consider increasing the validation sample size, reassessing the model fit, adjusting the 659 

overlap settings, or examining recurring and persistent sources of misclassification within the 660 

audio data before reapplying the threshold optimisation. Although the precision target was not 661 

reached for this site, these findings emphasise the variance in learning detector performance for 662 

the same species across different locations with varying acoustic environments. This supports 663 

previous observations that calculated optimal confidence score thresholds are environment-664 

specific19, often varying dramatically depending on species assemblages and background noise 665 

levels. 666 

  667 

Additionally, as shown in Figures 1, 2, and 3, there are detections that fall below the newly 668 

derived thresholds that were manually identified as correct. This highlights one key trade-off with 669 

this protocol. Although this process reduces false positives, it may also exclude true positives and 670 

ultimately reduce recall. This effect has been demonstrated in other research looking at the 671 

effects of increasing the confidence score threshold26. However, given the large volumes of data 672 

produced by ARUs, comprehensive manual identification of species is impractical at scale and 673 

prone to human error3,24. In these representative results, manual review was used as a reference 674 

standard for evaluating the machine learning–based avian sound recognition model detections21. 675 

However, this does not imply that this method of review is fully precise, rather it serves as an 676 

independent benchmark to assess the protocol. In this context, statistically selected thresholds 677 

offer a practical compromise to allow for the processing of large datasets while still allowing for 678 

substantial numbers of detections. Where recall is of priority, a possible alternative method that 679 

incorporates this, involves calculating F-scores across a range of confidence thresholds and 680 

selecting the threshold that maximises the F-score29,30.  681 

 682 

The representative results here for the Glasgow and Cairngorms sites yield a higher precision rate 683 

using the newly generated confidence scores with the default overlap of 0 s, compared to 2 s. 684 

However, the 0 s overlap setting resulted in fewer total detections (Table 1), indicating reduced 685 

recall (i.e., a greater number of missed detections). In contrast, increasing the overlap to 2 s 686 

increased the total number of detections but also increased false positives, reducing overall 687 

precision. One explanation is that increased temporal overlap increases the likelihood that non-688 

target, mislabelled vocalisations are segmented multiple times, inflating the false positive rate. 689 

This finding contradicts previous studies reporting that an increase in overlap will increase 690 

detection resolution and precision19,29. Our results suggest that the effect of overlap may be 691 

context dependent and influenced by call structure and background noise. Researchers should 692 

therefore consider the trade-off between precision and recall when selecting an overlap. If 693 



   

 

maximising recall is priority, adopting a larger overlap may be justified, provided the increase in 694 

manual validation time is accounted for. However, for this study each ARU recorded 1-month of 695 

data, and large numbers of accurate detections were still produced after adjusting the confidence 696 

score threshold, even with the lower 0 s overlap (Table 1). 697 

  698 

The use of a statistically derived, species- and location-specific confidence score, is likely superior 699 

to techniques of simply increasing thresholds to reduce false positives. As demonstrated by Tseng 700 

et al26 higher thresholds yield a large number of false negatives (missed identifications). If higher 701 

thresholds were applied to the sites represented in this study, by theoretically shifting the 702 

threshold lines forwards in Figures 1, 2 and 3, a loss of a large proportion of true positives would 703 

occur. Conversely, applying a threshold derived for one site to a different acoustic environment 704 

may result in the opposite problem. A threshold that gives precise detections for a quieter site 705 

may be too low when transferred to a noisier site with more complex sounds and species 706 

assemblages, resulting in inflated numbers of false positives.  707 

 708 

Furthermore, the variability observed between the statistically derived thresholds in this study 709 

(0.23–0.54) for the same species across varying sites, indicates that a universal threshold may 710 

not be suitable. As this variation is reflective of differences in environmental noise and species 711 

assemblages among sites. 712 

  713 

The representative results here support the use of this protocol in improving detection precision 714 

when utilising the machine learning detector module19 to identify vocalisations within analysis 715 

software31. This process will allow users to efficiently filter large datasets, reducing the time and 716 

effort required for full manual validation of detections. The application of the logistic regression 717 

derived threshold means users can be confident in producing higher volumes of accurate 718 

detections. These detections can be used for a multitude of research purposes, such as for 719 

annotation and parameter extraction, for monitoring of species presence, creating training 720 

datasets, and for conducting vocal behaviour analysis. The differences in the precision and 721 

thresholds derived from each location for the same species also highlight the importance of 722 

location based and acoustic environmental context. Reinforcing the importance of utilising this 723 

process when using audio data from multiple locations, with varying acoustic environments. 724 
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